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1. Introduction 
The PC interface for the iSonic ultrasonic level and flow meter is a custom written 
software package able to run on any PC Windows platform. The interface provides for: 
 
Creation of configuration files for multiple iSonic units 
 
Creation of Template Configuration Files that can be re-used to create new configurations 
for units 
 
Communication with iSonic units, either directly via serial port or via dial-up link. The 
communication allows for remote configuration and data retrieval. 
 
Easy data storage, management and inspection 
 
Event data viewing, printing 
 
Advanced graphical data representation and manipulation 
 
Data export functionality to other PC software 
 
Live data tracking 
 
The interface is multi-lingual; users can select English, Afrikaans, Spanish, French or 
German. The entire interface, including data file representation, can be language changed 
whilst the program is executing. 
 
All configuration, event and data log information can be printed from this interface; the 
program performs special print formatting for each type of file. 
 
A multi-document interface is used as user interface, this means that multiple data files 
can be inspected and manipulated simultaneously. The interface allows for multiple 
window tiling, cascading, all the standard windows functions. 
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2. Screen basics 
 

When the program starts, the first look the user gets is as follows: 
 
 
 
 
 
 

 
 
A menu bar runs across the top section of the program, here the user can reach most of the 
functions that can be performed. The toolbar just below it makes accessing certain standard 
functions easier. 
 
The empty area that dominates the picture is the multi-document interface area that is used 
to show configuration information, data and event files. When the program starts up, the 
multi-document area is empty since there are no open files, except if the program was 
started from the Windows Explorer by selecting a file registered to be one of the iSonic file 
types (*.ibl, *.lrm, *.cfg). 
 
The Language drop-down box allows for other language selections. Currently the program 
allows for “English”, “Afrikaans”, “Español”, “Français” and “Deutsch”. Changing the language 
selection causes the interface to instantaneously change to the selected language. 

 
 

Tree - View Multi-Document Interface 

Language 
Selection 

Tool Bar Menu Bar 
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The yellow area on the left hand side is called the tree-view area, in it the user can explore 
what data was stored, create new units, perform new configurations, and other things. The 
tree-view interface works similarly to the Windows Explorer interface, double-clicking on any 
item with the boxed plus sign in front of it, will expand that particular branch, click on any 
other item in the list and the relevant file will open.  
 
 
The following icon’s are used in the tree-view operation: 
 

 Blue Tick mark, signifying that particular file is open in the multi-document interface. 
 

 Hand icon, this file is currently active on the multi-document interface. 
 

 This particular file is a configuration file 
 

 This icon signifies the start of a unit’s branch, in it is the configuration file and all the 
event and data files.  

 
 Event file icon, which is a text based file 

 
 This icon signifies a data file, which can be graphically represented 

 
A screen shot after some of the branches have been opened up: 
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The program’s caption will always display the currently open file name. 
 
In the previous picture the user has “Drilled Down” to a data log from “iSonic-1”, there are in 
total 3 files open: a template file (Factory Default (USA), a configuration file (iSonic-1), and a 
data file which is the active file.  
 
The Templates are provided to make configuration of a new unit easier. Once a new unit has 
been created, simply ‘drag-n-drop’ the proper configuration from the templates to the new 
unit. 
At a later stage, once a unit’s configuration has been adjusted properly, it is possible to 
create a new template from this units configuration. To do this, select the units configuration 
file and click on “File”-> “Save As”. 
 
It is also possible to “Import” a configuration file from another source, for instance when 
transferring a configuration from another PC. To do this, use the “Import Configuration” 
option. A unit will be created using the name of the imported configuration file. 
 
The multi-document allows the user to view multiple data at the same time, as shown below: 
 

 
 
Via the “Window” menu pull-down, files can be Cascaded, Horizontally or Vertically Tiled. 
Alternatively, the user can arrange the windows manually to suit the situation. 
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3. General configuration 
 
When clicking on a configuration file of a unit, the following screen is presented: 
 

 
 
 
This screen is the first of six configuration screens that together make up the entire 
configuration of a unit. By selecting General, Application, Analog, Digital, Relays and SMS, 
the user can select different parts of the configuration information.  
 
The “General” area shows: 
 

• “Address”; this address is used in communication when the unit is coupled onto an 
RS485 network. 

 
• “Port2”; configures how the data reporting port is configured. The STALK selection 

is the proprietary protocol which can be used over RS232 / RS485 or via a MODEM. 
This protocol allows live data and status requests, data log retrieval and even unit 
configuration changes. The “TEXT” selection results in the unit reporting the 
measured data every second, this can then be easily interfaced with a data capturing 
application. The connection radio buttons, mark whether the connection on Port2 is a 
direct connection or via a line or GSM MODEM. The iSonic will initialise the MODEM 
automatically, handle the connect sequence and, once connected, will apply the 
selected communications mode (STALK or TEXT). The software can handle standard 
AT compatible modems but also GSM modems. If a PIN is required for the latter, 
then this can be configured in the SMS screen. 
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• “Unit Telephone”; used for communications to/from the unit via a telephone 

connection. This number is used when a telephonic connection (Select “MODEM”) is 
made to an iSonic unit. 

 
• “Initialisation”; is used on the iSonic side, in it extra configuration commands for the 

MODEM can be specified. These commands are the standard AT command set and 
they must be separated by the ‘|’ sign in case of multiple commands.  

 
•  “Units”; here the user can configure the iSonic unit which units to use for Level, 

Volume, Flow & Temperature measurements.  
The iSonic supports: 

o Temperature: C°, F° 
o Level: mm, m, inch, ft 
o Volume: m3, l, acft (Acre Feet), gal(USA), gal(UK), bbl (Barrel) 
o Flow: m3/s, m3/d, l/s, cfs, Mgd(USA), gpm(USA), Mgd(UK), gpm(UK) 

 
• “Date Format”; the date format used for display purposes 

 
• “Language”; available languages are English, French and Spanish. This selects the 

interface language on the LCD of the iSonic unit. 
 

• “Data Logging”; data logging operations on the unit can be enabled here, the 
logging interval can be set in 1 to 255 minutes resolution. Please note that the event 
logging occurs asynchronously from this interval, entries into the event log are made 
whenever a relevant event occurs. The instrument has provision for 1000 event 
entries and 46080 data log entries. When the data log interval is set for 1 minute, 
enough space is available for 32 days worth of data. Setting the interval to a lower 
value, results in a longer duration data log. For instance when setting the interval to 5 
minutes, there will be space for roughly 5 months worth of data. 

 
• “Power Saving”; selects low power operation, a unit can go into sleep mode and 

wake up every interval to perform measurements and put them into the data-log. If 
power saving is selected, the data-logging operation is automatically enabled, the 
data-logging interval also sets the power wake-up interval. 

 
•  “Error Delay”; is the duration of time whereby the unit keeps a last known good 

measurement value. If no sensible echo information can be found, the last known 
good value is maintained until this time lapses. After this timeout, the error current is 
applied on the analogue outputs.  
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4. Application configuration 
 

 
 
Here each transducer’s application is configured. The “Enabled” tick-box enables or disables 
the specific transducer’s operation. The “Application” area shows: 
 

• “Name:”; from iSonic Version 2.0.0 onwards, it is possible to name the Inputs and 
ouputs of the iSonic. Users can customise Sensor, Digital input, Relay and Analog 
output names; each of these pages on the configuration dialog now has a field 
"Name". Although customisation can only be done from the PC interface, the 
customised names are displayed and used in GSM communications by the iSonic. 
Names are limited to maximum 15 characters, but some of the controller screens will 
truncate them to shorter strings. Some special characters are not available in the 
GSM character set we use (GSM 03.38) and will be converted to a standard ASCII 
character (e.g. ó and ô to o) for GSM messages.  

 
• “Model:”; this sets the transducer type that is connected to the first transducer 

connections of the iSonic. Three standard types are defined; 20, 34 and 52kHz. In 
addition, non-standard transducer types can be defined by selecting “other”. With this 
selection, the “Frequency” box is enabled for editing and the relevant frequency can 
be entered. 

 
• “Type:”; indicates the application that is measured, this can be Level, Volume, Flow, 

Function, or Speed of Sound. The tabbed interface situated in the middle of this 
configuration screen, changes in response to a selection made in the “Type” box. The 
‘Function’ entry marks the fact that the user wants to make use of both transducers to 
perform a combined measurement. The Speed of Sound type is used when a non-
standard environment has to be measured, a special compensation transducer is 
then used on the transducer two connection. 
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• “Function:”; is only enabled when the user has selected “Function” in the “Type” 

box. Here the combined operation can be selected which can be Add, Subtract, 
Average or Differential Flow. For more details on this configuration, which can be 
confusing to set-up, please refer to Appendix 1, “Dual Functions”. 

 
• “Alarm:”; can be enabled or disabled. The “Set at PV above” and “Set at PV below”, 

refer to percentages of the Processed Value. For “above”, the alarm will go off at or 
above the entered value, only to stop once the hysteresis value has been passed. 
The same goes for the “below” entry. In the below example the alarm is set for 95% 
and 5% with a hysteresis of 2%:  

 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 

In the above, the alarm will go off at a Process Value of 95% and will only stop once the 
PV drops down to 93% again. On the bottom end, the alarm goes off at a Process Value 
of 5% and will only stop once the PV rises to 7% again. 
 
Please note that 0% and 100% corresponds respectively to the Minimum and Maximum 
as set in Level, Volume or Flow. This also implies that 0% might be a larger process 
value than 100%. 
 
When clicking on the “Echo Processing” button, the following settings are shown: 
 
 

 
 
 

100% 
 

95% 
93% 

 
 
 
 
 
 

7% 
5% 

 
0% 

Alarm switches ON 
Alarm switches OFF 

Alarm switches OFF 
Alarm switches ON 
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• “Filter:”; this configures the averaging that takes place for this transducer. Available 
entries are; None, 16, 32, 64 and 128. If fast changing targets need to be tracked, 
care should be taken to select a lower averaging number. For greater stability, a 
higher average can be chosen. 

 
• “Deadband:”; configures the size of the area in front of the transducer which should 

not be measured. Different transducer types have different deadzone areas, in 
addition to this the user might want to configure an area that should not be measured. 

 
• “Firing Rate”; sets the repeat rate of the transducer transmit pulses. This setting can 

be Fast, Medium or Slow. This setting can be used to either make the system react to 
very rapid changes or, in combination with the Filter setting, ensure an even longer 
stabilisation period. 

 
• “Gain”; this section allows the user to customise the installation even further. It 

allows a gain profile to be set over the total span of the measurement. If for instance 
a difficult target is measured, then high gain can be selected. Inside tanks, because 
of the enclosed space, a “No gain” setting is more often than not the best solution. 

 
The central area of the configuration screen shows Level, Volume or Flow, depending on 
what “Type” was selected by the user. 
 
For application selection: 
 

• “Level”, enter the Process Values of the minimum and maximum to be measured 
values. The ‘Min” and ‘Max’ values can be entered with values in any order. 

 
• “Volume”, the ‘Min’ and ‘Max’ describe the minimum and maximum measurement 

points. Click the button on this section to describe the vessel that has to be 
measured. The “Tank setup” screen appears: 
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Here a description can be made to select what sort of volume is to be measured. In 

all cases volume will be calculated in the units selected under the general set-up.  
 

Available selections for volume calculations are: 
• Vertical Cylinder; here Tank Bottom describes how far away the bottom of the 

tank is from the face of the transducer. The diameter is the tank diameter. No 
other parameters are needed.  

• Vertical Cylinder + Cone; as per vertical cylinder but this time a cone is added 
on the bottom end. An extra text box is made available which describes the 
length of the cone, the iSonic will perform the relevant calculations. 

• Horizontal Cylinder; again Bottom and Diameter are available as parameters, 
this time an extra parameter called Length describes the length of the 
cylinder. 

• Sphere; only Bottom and Diameter are available, describing a round tank. 
• Scaled; allows easy entry of a calibrated tank. Often, in Oil and Chemical 

industries, tanks have been calibrated in Gallons per Inch or similar calibration 
values. Entering this value together with the Tank Bottom value is enough to 
describe the tank. 

• Custom; this is a reference to a non-standard tank shape. In this case the 
user can use a table of entries, but the Tank Bottom is still required for 
calculating the head. After this selection has been made, the Custom table will 
automatically appear. 

 
• “Flow”, an entry similar in style to the volume entry, the following “Weir/Flume 

specification” screen appears: 
 
 
 
 
 
 
 
 
 

Here a description can be made what flow measurement construction is used. The 
available settings are: 

 

• V-Notch weirs 
• Rectangular weirs with end contractions (“Contr. Rect.”) 
• Rectangular weirs without end contractions (“Suppr. Rect.”) 
• Trapezoidal weirs (“Cipolletti”) 
• Parshall flumes (“Parshall”) 
• Leopold-Lagco flumes (“Leopold-Lagco”)



Analog input configuration  11 / 28 

UF_iSonic2000_PC-Schnittstelle_0704_e.doc 

 
The last entry is “Custom”; here a non-standard flow can be described using up to 15 
entries in a custom table.  
 

 
 
 
Special assist features are available here, in the form of buttons marked “Manning” 
and “Venturi”. Use either of these two buttons to have the PC software fill in the 
custom table for these respective applications.  
Please note that the “Manning” calculations are intended for partly filled round 
conduits, and that the roughness table is a guide only. 
 

5. Analog input configuration 
This configuration screen looks as follows: 
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This screen allows the configuration of the two analogue inputs on the iSonic instrument.  
 
The analogue inputs can be: 

• Logged only 
• Used as an alarm input 
• Used as a control for a relays 
• Used as a control for the Analogue Outputs 

 
The “Enabled” tick-box marks whether the specific input has been enabled.  
The “Type” can be used to specify the input type, either a 4-20mA current input or 0-5V 
voltage input.  
 
The alarm works as all other alarms in the system, above a certain value or below a certain 
value the alarm will trigger. The hysteresis percentage sets the boundary width to ensure a 
stable alarm condition. In the above example the alarm would trigger at 95% and would stop 
again at 93%. Similarly at the bottom end of the input, the alarm will trigger at 5% or below 
and stop at 7%. 

 

6. Digital configuration 
 

 
 

The Digital Inputs can be used as “Trip Lines” for process control or as counter input from for 
instance a water meter or similar device.  
 
If configured as a control input, the user can specify which relay is controlled by this input. If 
the input is active, the relay will switch off regardless of other process values. 
The “Invert Logic” allows the configuration of negative logic, if set, the controlled relay will 
switch off when the input is inactive. Typical usage for the inputs in this configuration is an 
out-of-process alarm and disabling of the control. 
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If configured as a counter, the count is incremented for the duration of the set window and 
logged, at the beginning of each window period the count is set to zero. The “Scale” 
indicates what each count pulse means, if volume is set for cubic meters then in our 
example, each count is one cubic meter. 

 

7. Analog output configuration 
 
This configuration screen looks as follows: 
 

 
 
This screen allows the configuration of the two analogue outputs on the iSonic instrument.  
 
The analogue outputs of the instrument are always a 4-20mA signal. They can be set to 
either plain retransmit a scaled process/measured value or to perform a set point control 
(PID). The controlling channel can be set to Transducer 1, Transducer 2, A/D Converter 1 or 
A/D Converter 2.  
 
As per usual the name of the Analog Ouput can be set in the “Name” field. 
 
In the case of retransmit the current output of a channel is set by selecting a relevant range 
of process values or measured values (A measured value is the distance measured by the 
transducer, before the value is converted to a volume or flow).  
The iSonic will interpolate the 4-20mA current output between the two selected percentage 
values. 
 
The “Error Current” is output on the channel when the input process value has an error. (for 
example: lost echo) 
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In case of “Setpoint control” a PID regulation process kicks in action where the channel’s 
output current is set in response to changes in the process value. The instrument will attempt 
to control the process in such a way that the required setpoint is always correct. The 
controlling action can be set to be “Direct” or “Reverse” indicating whether the response 
should be normal or inverse to the measured error. The PID values can all be individually set 
by the user to tune the process to the required response speed and stability. For more details 
on PID refer to a PID handbook or access the Internet, many useful tutorials are freely 
available. 
 
The "Deadband" setting defines the area around the Setpoint where the output is kept 
constant. When regulating from outside the deadband the output is only made constant after 
the input has crossed the Setpoint. (Known as zero-crossing) 
 
For instance, if the “Setpoint” is set for 30% and the “Deadband” is set for 1%, then the 
output will not change for process values between 31% - 29%. This deadband value can be 
made as small or as big as the process demands, it entirely depends on the required activity 
of the controlled device. 
 
The above described “Setpoint control” section allows each output channel to control an 
individual output based on an individual input. In addition to this mode it is also possible to 
link both outputs to a single measured process. This is done by setting the “Interlocked” 
option. In this case the PID settings are taken from “DAC1”. 
 
This will result in both outputs being used to control a process, where the outputs mirror at 
the 4mA point. The entire regulation range can be graphically represented as follows: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Meaning that Output 1 and Output 2 are mutually exclusive, if the PID response is in the 
100% to 50% domain, then Output 1 is active and Output 2 is 4mA, if the response is in the 
50% to 0% domain, then Output 1 is 4mA and Output2 is active. 
 
As an example, if a flow has to be controlled by either taking away some water (Valve1) or by 
adding some water (Valve2) then this can be done by connecting each valve to an analogue 
output and by setting the “Interlocked” mode. 
Assuming a start condition where both valves are closed (4mA), then the following will occur: 
 
If the process value is set for 30% but is measured as 35% (flow rises) then in response the 
Output1 current will increase. The Output2 current will remain 4mA.  
In process terms this means that Valve1 opens and Valve2 remains closed. If the flow 
returns to 30% then the valve openings will remain as they are.  
For a decreasing flow, Valve1 / Output1 will initially close, if the flow continues to be too low, 
then Valve2 / Output 2 will start to open whilst Valve1 remains closed. 

20mA 

20mA 

4mA 
4mA 

Output 1 

Output 2 

Regulation 
Range: 

100% 

0% 

50% 
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8. Relay configuration 
 
This screen looks as follows: 
 

 
 
There are four relays that can be controlled by this configuration screen, the fifth relay on the 
instrument is reserved as an alarm relay. Each relay can be controlled by one selectable 
process variable, each process variable can control multiple relays.  
In addition to this there are two timing mechanisms available to drive each relay. The daily 
timer can be used to enable the relay for a set daily period only. The second timer is a 
periodic timer, which can be set to activate and de-activate for a set number of minutes.  
A combination of time function and process value is possible, but please note that the timer 
function has priority. Between the two timer functions, the daily timer has priority. If used in 
combination with a sensor, the timer function can only de-activate and not activate a relay.  
The digital inputs are listed on the screen and they have absolute priority, if a configured 
input is active then the relay stays off, no matter what. 
 
The items on the screen are: 
 
“Activated By”, this is where the controlling variable is chosen. This can be the transducers 
or the analogue inputs, but the user can also select to use a timer only by selecting “none” as 
the activating control.  
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“Timer”, can be disabled, daily and daily + periodic. To achieve a periodic timer without a 
daily time, simply ensure the daily time on and off values are identical. 
 
“Sensor”, defines at which values of the process variables the relays are switched. 
The program clarifies the behaviour of the relay by representing it graphically: 
 
 
 
 
 
 
 
 
The bottom line is the “Off” state for the relay and the top line is the “On” state for the relay. 
The left hand upright defines the “On” cycle and the right hand upright represents the “Off 
cycle”.  
In the above case, the relay will switch on when the PV drops to 10% and will stay on until 
90% PV is reached. 
 
If the set up is inverted: 
 
 
 
 
 
 
 
In this case, the relay will switch on when process value rises to meet 90% and will switch off 
again when the PV drops below 10%. 
 
 
“Daily”, defines the start and stop points for the daily timer. If these values are identical, the 
daily timer will not work, even if “Daily” is selected 
 
 
“Digital Inputs as trip lines”, lists for the users information which digital inputs have been 
configured to “trip” this relay. 
 
 
“Pump Rotation”, this allows a pump rotation option between a single set of relays. The 
relays that have been selected with the rotation option will automatically cycle to ensure even 
wear on the switched equipment. This option is especially useful when multiple pumps are 
used on a single tank/vessel, although the pumps can still be set to operate at different 
levels, each pump’s usage will be cycled so that each pump gets the same average 
operational time. If digital inputs are used, when activated, they will remove the relevant 
pump from the queue (making maintenance on a single pump possible whilst continuing 
normal operation). 

 
1

0 
10.0 

90.0 

 
1

0 

10.0 

90.0 



Relay configuration  17 / 28 

UF_iSonic2000_PC-Schnittstelle_0704_e.doc 

 
“Periodic”, defines the time durations of the On and Off cycles of the periodic timer. These 
durations can be specified with a resolution of 0.01 minutes. 
 
 
“Delay Before”, defines the delay before a relay action should take place or after a relay 
action should stop. All relays (alarm and normal) can have an activation and a de-activation 
delay independently specified with seconds resolution (0-999s). The relay waits a specified 
time before reacting to a process state requesting (de-)activation. The relay reacts only if, 
after the wait period has elapsed, this state still exists. Delay of 0s = no delay. One can have 
e.g. activation delay of 10s and de-activation of 0s. An ON-delay of 0, with non-zero OFF-
delay would emphasise spurious process states, and an OFF-delay of 0, with non-zero ON-
delay would filter out spurious process states. Delays are only applicable when related to the 
process value; an alarm triggered by a digital input would not have a delay, and if a normal 
relay is only switched by timers, there's no delay either. If a periodic timer is linked to a 
process relay, the timer cycle would only start once the relay's activation delay has elapsed, 
ensuring the usual synchronisation with the process. An event file entry for an alarm is only 
made after the delay has elapsed, i.e. once the alarm relay is actually triggered. Factory 
default = 0s delays. 
 
The instrument relay percentage settings are calculated according to the 0% and 100% 
settings of the channel that is measured. 
 
The formula for calculating the measured percentage is as follows: 
 

%0%100

%0

ValVal
VallueMeasuredVa

−

−
 

 
Example 1: 
 
Here the 0% value is smaller than the 100% value. 
If the 0% value = 100mm 
And the 100% value = 1000mm 
And the measured distance = 300mm 
Then: 

%2.22%100222.0
1001000
100300

=×=
−
−

 

Example 2: 
 
Here the 0% value is bigger than the 100% value. 
If the 0% value = 1000mm 
And the 100% value = 100mm 
And the measured distance = 300mm 
Then: 

%7.77%100777.0
1000100
1000300

=×=
−
−

 

 
These percentages are also available on certain running screens of the unit.
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A few examples for relay set-ups: 
 

• A tank is filled with water from a borehole, and is discharged into a household. The 
rule is that the borehole pump should only run when the tank is emptied below 50% 
and also that the tank should never fill above 95%.  
In this case, set the ON percentage to 50% and the OFF percentage to 95%. As soon 
as the tank empties below 50%, the relay (pump) will activate and will only de-
activate when the measured level/volume is above 95%. 

 
• A stream empties into a holding tank for further distribution into a network, the 

network is only allowed to take water when enough supply is available (Tank above 
50%), when the tank reaches a critical level (10%) a valve shuts off the outflow.  
In this case, set the ON percentage to 50% and the OFF percentage to 10%. The 
valve will open once the measured level/volume is above 50% and will only close 
once the process reaches 10% or less. 

 
Other combinations of the above are also possible. With the Normally Open and Normally 
Closed contacts being available, other logical combinations can be made. 
 
 

9. SMS configuration 
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The iSonic unit contains software to drive a standard GSM modem. The GSM modem can be 
used for normal data traffic but can also be used to send SMS alarms and status messages.  
 

• The Station ID is a text string that is used in the SMS message to identify where the 
message originates. 

• Mobile Phone #1 and #2 are the numbers that unsolicited SMS’s are sent to in case 
of an alarm condition. The user can select to only sent to one number by leaving the 
second number blank. The SMS’s are only enabled if at least Mobile Phone #1 is 
entered. 

• Unit Telephone and Initialisation are the same fields as displayed on the “General” 
configuration page. For details, please refer to the description under “Config – 
General” 

• The “PIN” field is optional, it contains the PIN code for the SIM as used in the GSM 
MODEM. If this field is filled, the iSonic assumes a PIN has to be communicated to 
the MODEM on start-up. 

• Under “Events available for SMS messages” the user can select which alarms he 
wishes to receive on his mobile GSM phone. 

 
All event messages can be customised by the user by simply right-clicking on the message. 
The maximum length is 44 characters, and this customisation can only be done from the PC 
interface. The hints message displays, in the interface language, the default messages. The 
user can also select to replace all the messages by their language-specific default strings via 
a button positioned at the end of the message list.  
The format of the transmitted SMS is as follows: "Station: [Channel name - ]message"; if the 
event does not relate to a specific channel (e.g. Datafile cleared), no channel name is sent. 
The channel name is as customised in (1). Please note that no translation is done on any 
customisable string, be it a name or an SMS message. 
 
In addition to this functionality, the user can also interrogate the iSonic unit using a GSM 
phone.  
By sending an SMS with a certain message content from a mobile phone, the iSonic will 
respond to that message.  
 
The request message content is defined as follows: 
 
The first four characters must match the unit’s password, the fifth character must be a 
command character. If this message is received by the iSonic, the unit will send the 
appropriate response back to the originator of the SMS. 
 
Allowed status request messages are: 
‘0’ – for status request, this returns only active channels, and includes channel names (as 
customised) and proper formatting.  
‘S’ – Sensor Status 
‘D’ – Digital Inputs 
‘R’ – Relay Status 
‘A’ – for Analog Inputs 
 
It's obvious that the maximum sms length may be exceeded if many channels are active, or 
long names are chosen. In that case, the message is simply truncated. 
 
As an example; if the password for the iSonic unit is set up to be 1234, then simply send an 
SMS with the content: 12340. This will result in the unit responding with an SMS to your 
phone, showing the current measurements. 
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It is also possible to control the behaviour of the iSonic by using SMS messages. The 
setpoints for analog outputs configured for PID control can be set via the same type of SMS 
message.  
 
Use "xxxxcddd.d" to set channel 'c' (1 or 2) to ddd.d percent; e.g. 0000135.5 will adjust 
channel 1's setpoint to 35.5%. After a successful change, a confirmation SMS is returned to 
the sender. 
A request to adjust the setpoint to 0% will be ignored (0.1% is lowest acceptable value). The 
second channel of a linked pair will ignore this message. 
 
 

10. Communications – connecting to a unit 
The program has basic settings for communication with external units. When selecting from 
the menu bar: “Communication  Port”, the user can set which PC communications port to 
use at which speed and which modem to use should that connection be required. All 
settings, once made, are automatically stored by the program. 
 
An iSonic unit always communicates on Port 1 at 115200 baud and on Port 2 at 9600 baud. 
Port 1 is typically used to connect via RS232 to a nearby computer (laptop), and Port 2 is 
typically used to drive a Modem or RS485 network.  
 
To communicate with a unit, click on the unit name in the tree view and then select from the 
menu bar: “Communication  Connect”. An alternative method would be to right-click on the 
unit name and then selecting “Connect”. In both cases the “Connect to iSonic” panel 
appears: 
 

 
 
If we assume the connection is via a serial line to the computer, the RS232 selection can 
stay as it is. For other types of connection, via an RS485 network or a Modem, click on the 
correct option before connecting. 
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Click on the Connect button to establish a connection with the instrument. Once the unit is 
connected, the serial and version number appear and the bottom “Connecting” message 
changes to “Connected”. In case of a MODEM connection the “Connecting” message will first 
change to “Answered” and then to “Connected”. 
 
At this stage it will become possible to click on any tab of the connect box and perform the 
following actions: 
 

• “Realtime Clock”, shows the user what the time is according to the iSonic and 
according to the PC. The “Write Clock” button allows setting of the iSonic time from 
the PC time. 

 
• “File Status”, shows the size of the Event and Data log files. 
 
• “Configuration”, allows for upload (Read Config.) and download (Send Config.) of 

the configuration information for the iSonic. If the configuration file is sent, the current 
configuration information for this unit is passed on to the unit. If the configuration 
information is read from the unit, it will be automatically stored in the current 
configuration file for this unit on the PC. 

 
• “Data Log”, allows reading of the data log from the unit, this information is stored in 

the tree view under the current unit’s group. The “Clear Data” button re-initialises the 
unit’s data log to zero entries. Not all the data has to be transferred every time a 
connection is made, the user can select the required start and stop times. 

 
• “Event Log”, allows reading and clearing of the event messages on the unit. Again, 

the information is stored in the tree view under the current unit’s branch. 
 

• “Live Status”, shows the status of the unit. Shown are: the transducer and analogue 
measurements, plus the status of the digital inputs and the relays. 

 
 

11. Signal capture 
It is possible to capture and display the echo signals from each of the transducers. This is 
done via the “Signal” command, which is available from the menu bar or by right clicking on a 
unit in the tree view. 
The resulting screen looks as follows: 
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Note that “Capture” and “Download” are only highlighted if a unit was selected before the 
“Signal” command was given. 
 

• “Open”, allows a previously stored signal file to be inspected. 
• “Capture”, captures the echo signal from the selected channel to the instrument’s 

buffer. 
• “Download”, retrieves the signal data from an instrument. At this stage the user is 

prompted for a filename under which the information should be saved. 
 
Once a signal is loaded onto the graph section it can be zoomed manually by mouse clicking 
on the area to be inspected from left top, dragging a window to right bottom: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
It is also possible to pan the view, right click on the graph and drag it along. 
Zooming back to full screen is achieved by a reverse zoom-in action, drag a window from 
bottom right to left top, any size, anywhere in the graphic area.  
 
 

12. Event file operations 
Event files, once stored, can be opened from the tree view by clicking on their file names. 
Once an event file has been opened, the user can scroll up and down to view through the 
file.  
Printing can be done for the whole file or when a selection has been made, that specific 
section will be printed. 
In addition to these functions, the user can also export the data to a text based file, select 
“Save As” from the “File” entry on the menu bar. Either the whole file is exported or, when a 
selection was made, that particular selection is exported.  
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An opened event file can be closed again by selecting “File  Close”, or selecting the bottom 
‘x’ mark of the two ‘x’ marks on the right top of the program. 
To remove an event file from the PC system, either select: “File  Delete” or right click on 
the file and select “Delete log”. 
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13. Data-log file operations 
 
Data log files, once stored, can be opened from the tree view by clicking on their file names. 
What appears is the data represented in graphical format: 
 

 
 
All logged (Enabled) traces are shown, and each trace can be manipulated individually to 
inspect the data. The data can be shown in its original logged units or can be displayed for 
other unit types. In the above graph, flow is displayed in “mgd” (million gallon per day), but by 
selecting another unit under “Flow”, this can be changed to any other flow measurement 
type. 
 
During navigation with the cursor over the data area, the bottom tool bar in continuously 
updated with the cursor position information, in this way it is very easy to determine the exact 
information of a data point. 
 
To zoom into a section, drag a window around the to be inspected data from the top left side 
to the bottom right side. To reverse zoom, perform the reverse action, from bottom right to 
top left. Once data is zoomed, it can be dragged by right click & dragging the mouse. 
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The “Update” button allows the user to update the display if needed, sometimes this is 
required if traces are disabled or enabled by the user. 
The “Grid” enables/disables a grid display. 
The “X Zoom” tick box enables / disables zooming into higher time detail.  
The “Single Y Zoom” tick box enables/disables zooming of a single trace only. If enabled, 
only those traces that are listed on the left and right hand side axes are zoomed. 
 
The program will automatically show the traces that were logged, and the user has the option 
to enable/disable the available traces in the tick boxes underneath “Plot”. 
When clicking on the coloured boxes of each trace, the user has the option to change 
colours, use this trace as the right hand axis, and even apply manual scaling. 
 
Under “Left Y”, the user can select which data has to be shown on the left hand axis, only 
one set of data can be shown on the left axis and only one set of data can be shown on the 
right hand axis. 
 
The channel names are also used in the data, status and stats displays. Names on a data 
graph can be changed via the axis dialog (click on the coloured square). These changes can 
be saved with the file via Save As. 
 
The “Week” button arranges the data in a weekly interval, starting from the current leftmost 
position. In this way it is possible to view the data in a week-by-week fashion. 
 
The user also has the option to cut certain sections of data out of the graph; this is achieved 
through right clicking on the graph and selecting the “Select Data Segment” function. Two 
white bars appear which can be positioned anywhere on the graph. When right clicking 
again, select the “Hide Data Segment” function and the selected area of the graph will be 
hidden. The data, once manipulated, can be saved as a new data file (Use File->Save As). 
The original log file will always retain the same data; it cannot be changed by a user. If 
mistakes were made in the selection process, close the file and re-open it again. 
 
Multiple data sets can be put together into a single file, by using the function “Append” which 
can be found under the “Display” tab. The full integrated set can then be saved via the “Save 
As” option.  
Select the earliest data-log to start with, and then append other files, either sequentially or in 
one step by selecting multiple files. Please note that once append has taken place, only 
newer files can be added, older files are not integrated correctly. Multiple files with similar 
data are handled correctly. 
 
It is possible to export the graph in a CSV format (Comma Separated Values), which can be 
read by external spreadsheet programs such as Excel. Select from the menu bar “File  
Save As” and then select in “Save as Type” the “Comma Delimited File (.csv)” entry. In this 
manner, the data log can be exported partially or as a whole, depending on whether the user 
has “hidden” data. 
Alternative methods are the “Display  Save as Metafile” and “Display  Save as Bitmap” 
functions. These functions store a graphical image of the data as it is currently shown on the 
screen. 
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14. Data-log statistics 
 
Once a data-log has been selected (see previous section), it is also possible to extract 
statistical information. Do this by selecting from the toolbar the option; “Display, Tabulate 
Statistics”. 
 
The selected Y-axis (left hand side) will be processed and a totals display will be shown: 
 

 
 
The user is allowed to make different interval selections (Hour, Day, Week, Month) and 
change the scaling of the totals column.  
The data is arranged into Minimum, Average, Maximum and Peak:Average columns, in each 
column the maximum (or minimum) is indicated in Bold-Red. At the bottom of the columns, 
once again a summary of the peak values is shown in a yellow-marked row. 
 
The data can be printed or saved to a .csv file, which can be read into a spreadsheet.  
 
The data can also be graphically displayed, do this by selecting the “Graph” tab.  
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The resulting screen looks as follows: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

15. Dual functions 
This appendix describes in detail the configuration of dual transducer set up’s, this section is 
provided since these type of configurations can be confusing. 
Even though the measurements are combined, individual transducers can still be used for 
control purposes. For example where a total level is calculated from two transducers, 
transducer 2 can still be used to control a relay. 
 
The three easier to understand configurations are the options Add, Subtract and Average. 
When selecting these options the program displays the following comment: 
 

 
 
What is meant by this is that when selecting Transducer 1, the “Function” block is enabled 
and the relevant option (Add, Subtract, Average) can be selected.  
The actual type of measurement (Level, Volume, Flow) is selected under the “Transducer 2” 
configuration.  
 
Measurement details must be entered for each transducer. The measurement for each 
transducer is performed by the instrument separately and then the results are added, 
subtracted or averaged, resulting in a final measurement result. 
The measurement result is always represented on the Transducer 1 channel. 
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The somewhat more complex dual function is the “Differential Flow” configuration.  
This function has been implemented to allow measurement on flumes or weirs using a dual 
transducer set-up. In all cases Transducer 1 must be the transducer that sees the most 
“Head”. This usually means that Transducer 1 is the upstream unit and Transducer 2 is the 
downstream unit.  
This operation only works for: 
 

• Parshall Flumes with submerged flow 
• Custom Table 

 
On Parshall flumes, flow compensation is performed when there is submerged flow (Flume 
overloaded). This compensation only functions under the following conditions: 
 

• Where the throat size is between 1 and 8 foot and a submergence ratio greater than 
0.7. 

• Where the throat size is bigger than 8 foot and the submergence ratio is greater than 
0.8. 

 
The correction factor that is applied is an approximation of various published tables and 
graphs, and may not be accurate in all situations. From a technical point of view, it would in 
any case be better to use a correctly sized Parshall flume, rather than rely on submerged 
flow correction factors. 
 
For the custom table selection, the principle behind this set-up is to measure the levels of 
both transducers, subtract them (measured level = level TRD1 – level TRD2), and then 
process the level according to a customised look-up table. 
 
 
When selecting this option under Transducer 1, the following message is displayed: 
 

 
 
With this is meant that the entire flow operation is configured under Transducer 1. For 
Transducer 2 the type is automatically locked into “Level” and the user can only configure the 
minimum and maximum level values for that transducer.  
The only allowed weir type (“Select Weir”) is Parshall Flume or “Custom”. 
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